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.9L p p { e - Q I n c. 1Jiary 

This Meeting 

General meeting: 
Demonstration: 
Committee meeting: 

Oct. 20th 

Sunday 
October 20th 

ll.OOam - 4.30pm. 
2.00am start. 
3.00pm start. 

Demonstration 

Apple-Q Inc's Annual General Meeting and 
lOth birthday party. Committe Elections 
and drink and food for all members. 

Things to come .. 

The Committee tries to set up demonstrations and 
other events like the auction to cover the many and 
varied tastes of our members. We are always on the 
lookout for anyone who might like to help in this area 
to either run a demo or suggest ideas for future 
demonstrations or events. 

It really does not take great computer skills and 
knowledge to present a demonstration, just a basic 
knowledge of the topic being presented. It could be a 
demonstration of software, for example an art 
program or music program, or on hardware like a 
scanner or a video card. 

If you would like to present a Demonstration or 
like to see one, let us know. Feedback from club 
members aids us in planning future meetings. 

Some Demonstrations I events 
Planned for 1991 

Educational Software reviewed 
The Macintosh LC 
Music and the Apple 
Scanners and OCR for the Apple II 
Auctions. 
Annual General Meeting. 
Apple-Q Birthday Party. 

Next Meeting 

General meeting: 
Demonstration: 
Committee meeting: 

Nov. 17th 

Sunday 
November 17th 

ll.OOam - 4.30pm. 
2.00am start. 
3.00pm start. 

Demonstration 

A demonstration of graphics on the Apple. 
Note this will be the last meeting for 1991 
the next is in January 1992. 

I New Members I 
Information unavailable due 

to Audit 

I Renewals I 
Information Unavaiable due 

to Audit 

Article of The Month Award 

No "Member's Article" was nominated 

Trading Table 
Apple-Q Inc. has for sale to members blank 

disks & other items that we buy in bulk in order to 
save you money & generate funds for the club. 

5.25 DDDS blank disks 
3.5 DDDS blank disks 
3.5 DDHD blank disks 
Disk Satchells 

{Box 10} 
{Box 1 0} 
{Box 1 0} 
{Pkt 50} 

$8.00 
$14.00 
$22.00 

$7.00 

Note: Prices are subject to change without 
notice, but are correct at the time of printing. 



Apple-Q fl Public Domain Software 
Information 

0 

Apple-Q Inc. has a wide selection of Public Domain, Shareware and 
Demonstration software available to members. We charge a copying fee so the group 
can obtain more software to expand the library. The copying fee for 5.25 inch disks is 
50 cents a side with a minimum charge of $2.00. For the 3.5 inch disks, the minimum 
fee is $3.00 per disk, with "Disks of the Month" costing a little extra than the older 
software in the clubs library. 

"" 
... -

On the inside back page you will fmd a software order form. This form can be 
used if you wish to order by mail or you can order & pick it up at the meeting. For 
mail orders, remember to add $2.00 for postage & packaging. 

Meeting Format 
11.00 am - 12.00 pm- Informal period 

Trading table open, Hard copy Library Open 
Registration of members (new and renewals). 
PO Software Library sales. Raffle Tickets sold. 
Start of General Computer Time. 

12.00 pm - 2.00 pm- Special Interest Groups 
New Users (Beginners) SIG 
Apple //GS Computers SIG 
Macintosh Computers SIG 
Trading Table, Software Library continues ... 
General Computer Time Contiues ... 

2.00 pm • 3.00 pm • Demonstration 
Invited speaker to give a demonstration. 
followed by a question and answer session 
relating to the demonstration. 
Draw raffles etc ... 

3.00 pm • Start Committee Meeting 
SIGS, Trading Table, Libraries etc. close. 
General computer time continues. 
Committee meeting stans. 
Members are welcome to attend committe meetings. 

5.00 pm • (approx.) Open Day ends. 
End of the General and Committee meetings. 

Meeting Venu 
IHI®®JID®Ir IEldlrnc1IDUfi®rrn C®;mfrrr® 

Kuran Street, Wavell Heights. 

Vistors Welcome. 

Membership Fees ___ _ 
Adults/Students: $25.00 
Corporate Membership: $50.00 
Associate Membership: $10.00 (BBS only) 
Joining Fee: $10.00 (frrst year only) 

At the discretion of the Executive Committee 

Articles for Apple-Bug 
If you would like to contribute to Apple-Bug, please 
send in your article (on disk if possible) to Apple-Q or 
bring it along to the meeting. The deadline for Apple­
Bug is the Open Day meeting. Disks will be returned. 

Executive Committee 
Ann White 
John Finch 
Bob Godbehere 
Bob Godbehere 
Graham Black 
Kelvin Saggers 
Jeff Sellers 
Ian Millar 

President 
Vice-President 
Secretary 
Treasurer 
Registrar 
Editor 
Software Librarian 
Hardcopy Librarian 

(07) 371-4067 
(07) 260-5218 
(07) 808-3892 
(07) 808-3892 
(07) 883-1525 
Modem/Mail 
(07) 359-1339 
(07) 343-4261 

Assisting 
Vince Crosdale 
DaleRodgie 
Graham Wobcke 

Immediate Past Pres (07) 351-3090 
Mise/Disk of Month (075) 91-2819 
Assisting Software Librarian 

------ Bulletin Board 
Name: 
Telephone: 

Baud Rates: 

Data Specs: 

Sysops: 

Apple-Q Inc. BBS 
(07) 851-1711 [24 hrs- B.B.S.] 
(07) 351-3090 [7-9 pm- Voice] 
300, 1200n5, 1200 & 2400 
(CCITT & Bell) 
8 Data bits, 1 Stop bit, No Parity, 
Full Duplex 
Vince Crosdale, Graham Black 

Production Information 
The Apple-Bug was written with AppleWorks and 

Apple Works GS. Apple Works GS was used for the Page 
Layout. Apple-Bug is printed by the Hooper Education 
Centre. Thanks to Computer City for the use of the 
LaserWriter used to produce the original copy. 

More Info 
• The copying of Commercially produced software is not 
sanctioned by Apple-Q Inc. and members who do so risk 
expulsion from the group. 
• No one is allowed behind the Trading Table counter 
except the Committee members and anyone appointed to 
work at the Trading Table. 

Advertising 
Classified advertising is Free to all Financial Members. 
For non-members, the charges are $18.00 for a Half 
Page and $30.00 for a Full Page. For more information, 
contact the Editor . 
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Help Line 
Apple II General 

Bob Godbehere (07) 808-3892 7-9 pm & W!E 

Vince Crosdale 
DaleRodgie 
Graham Black 

Apple Ilgs 
(07) 351-3090 7-9 pm 
(075) 91-2819 7-9pm 
(07) 883-1525 1-Q pm 

Apple Macintosh 
John Finch (07) 260-5218 7-9 pm & W/E 

HyperStudio 
Kelvin Saggers (07) 800-4660 Modem Anytime 

HyperCard //GS 
DaleRodgie (075)91-2819 7-9pm 

AppleWorks (Classic) 
AnnWhite (07) 371-4067 7-9pm&W/E 

AppleWorks GS 
Dale Rodgie (075) 91-2819 7-9 pm 

Applesoft I Beginners 
Graham Black (07) 883-1525 1-Q pm 
VinceCrosdale (07) 351-3090 7-9pm 

Vince Crosdale 
Kelvin Saggers 

Jeff Sellers 

Communications 
(07) 351-3090 7-9 pm 
(07) 800-4660 Modem only 

Disk of the Month 
(07) 359-1339 7-9 pm 

Educational Programs 
Ann White 
John Aspland 
Geoff Galt 

(07) 371-4067 7-9pm&W!E 
(07) 368-2420 7-9 pm 
(07) 355-5161 School hours 

Machine Language (lie, gs) 
Dale Rodgie (075) 91-2819 7-9 pm 

Vince Crosdale 
Kelvin Saggers 

Jeff Sellers 
DaleRodgie 

Modems 
(07) 351-3090 7-9 pm 
(07) 800-4660 Modem only 

Software Library 
(07) 359-1339 7-9 pm & W/E 
(075) 91-2819 7-9 pm 

If you are free to aid other members and would 
like your name added to the list, let us know. 

Please only call between the times listed. 
W/E stands for weekend. 

Apple-Bug 

Editorial _____ _ 
6y 'l(efvin Saggers 

Well a year has passed and once again we fmd ourselves 
facing Committee Elections, and the worst fate of all the 
Apple-Q Birthday Party. As I will be attempting to hand 
the reins over to new editorial blood, at this meeting, this 
could well be the last time you will have to suffer reading my 
comments in this column. I would therefore, like to take the 
opportunity to thank those few who made my life a little 
easier by submitting articles. Although most where 
themselves committee members e.g., Dale and John, there 
where one or two articles from other members, and for that I 
am grateful. 

OK, down to business. Still on the subject of elections, 
as far as I am aware we still need people to nominate for the 
positions of, Vice President, Secretary, Editor, Apple //gs 
Software Librarian, and Apple Mac Software Librarian. So 
if you are interested be there on the 20th of October. 

Enough about the committee elections for now, lets 
move into the pretty poor excuses department and see what is 
lurking there. I know I promised an article on the new 
Lotus 123 for the Apple Macintosh for this issue, but I ran 
out of both room, and time. I will however place the article 
in the beginnings of next months newsletter, so that the new 
editor will have a bit of a head start. If he or she does not 
care to use it they can always toss it out. 

As you will read in Dales article, Apple have come to the 
conclusion that there are not enough Macintosh computers on 
the market as yet and so they are releasing more onto the 
market. Don't hold your breath waiting for any new Apple 
II models, they fall firmly under the heading of vapor ware, 
software upgrades for awhile yes, but new models never. 

It would not surprise this little black duck one bit to find, 
that once Apple and Ibm forge closer ties, Apple will tend to 
be less of the innovator, and more an Ibm Systems software 
house, and workstation terminal supplier, inspite of all the 
reteric to the contrary. Apple is going to worry more 
about appeasing the big boys once they have a foot in the 
door than users like you and I. If you don't think so, then I 
have several slightly used bridges for sale, cheap at half the 
price ... interested? . . . 

In spite of the fact that I have hidden It so well, I am m 
fact an Apple JIGS man, thru and thru. I know you will fmd 
this hard to believe, but well this may well be my last chance 
to admit it. My main hope is that over the past year, you 
have found something of interest in Apple-Bug regardless of 
your computer type, and that one day you too can afford to 
own the greatest machine of them all, the Apple ][. 

J!pp{e-Q Inc's lOtli 'Birtliaay 
free 

J!pp{e Ice Cream CaKf­
J!na Jippfe Ciaer. 
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By Kelvin Saggers 
This is the last article in the current series on 

HyperStudio. The next article you read on this topic, will I 
hope, be my review of HyperStudio version 3.0 which is 
said to be so much more powerful, and includes a lot of new 
'goodies', but still so very easy to use. 

This m~nth the article is based on the creation of a simple 
HyperStudro stack that does not 'do' to much but does allow 
you to see how animated and auto-activated buttons work and 
how the various tools and functions are used to create a 
usable stack. 

First up, aside from HyperStudio {or the HyperStudio 
Demo version available from the software library) you will 
.eed a blank data disk on which to save a few screens and 
your finis~ed stack. Once you have created your data disk, 
double click on the HyperStudio Icon, and wait for the 
package to present you with the Home stack screen. 

Creating a New Stack ... 
To create a new stack simply move the mouse pointer to 

the menu bar and then select New Stack from the File 
menu. HyperStudio will then close the current stack ( in 
this case the main HyperStudio Home stack ), open a new 
stack for you, and then place you on the first card. Choose 
the Preferences option from the 'Apple' menu and make 
sure only the Show Card number in menu bar, and 
Erase background on new card options are the only 
ones that have been selected with an X in the box next to 
each of these two options, and that there is an empty box next 
to the other options to show that they have not been activated 
for this stack. You may find that you will have to deselect 
some of other options, when this is done click on the OK 
button to exit the Preferences menu. 

Adding Clip Art ... 
At present the background colour of card 1 is white and 

w~ will leave it that way until we have imported a pie~e of 
chp art. The reason for this is that if you use the lasso to 
gather a piece of clip art (as we intend to do) then the colour 
you start the lasso on become the background colour and that 
is left behind once you transfer the clip art. The background 
colour of .the card your intend to place the clip art onto 
replaces this colour once the clip art is transferred. Thus the 
objec~ ~e wish to transfer might begin to look a little strange, 
once Jt IS placed on the card if we are not careful. 

For example, if we made the background colour black and 
transferred a piece of clip art from a picture with a white 
bac~gro~d, any pieces of the original clip art that are now 
white Will be replaced with black once the art work is 
transferred. This is something that you must get use to 
when you use the Lasso Tool in any program not just with 
HyperStudio. 
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To add a piece of clip art to our stack, simply choose the 

Add Clip Art option from the File menu on the 
HyperStudio menu bar. The standard Apple File Selector 
will then appear on your screen, and via it you shouldOpen 
the Computer picture file, from the HyperStudio Art disk 
{HS.ART, or your hard drive]. · 

Once the file has been loaded the art work will appear on 
your screen with the standard menu bar replaced by one with 
four Icons, two icons to represent tools for selecting the piece 
of clip art, the standard Selector Tool {cross hairs) and 
the Lasso Tool, a Stop Sign {Quit this option ], and the 
OK icon [for when you are ready to transfer the selected clip 
art to the card) . 

Select the Lasso Tool and move the pointer (which now 
looks like a small lasso) to just outside the picture of the 
Apple //GS computer that is about in the middle of the screen. 

Making sure you are on the white background click and 
hold down the mouse button and move around the outline 
(roughly) to surround the picture of the Apple //GS with the 
keyboard, drives and mouse, until you cross the position that 
you started out from. Release the mouse button and the 
picture should now be highlighted. If something went 
wrong just click outside the selected [highlighted] image and 
try again. 

Once you have the selection you want, click on the OK 
icon on the Menu Bar, your screen should now show the 
selected image of the Apple Ilgs 'floating' on the background 
of card 1. At this point you can move the clip art around, 
delete it etc., but as we however went to a great deal of type 
to get this far we will keep our ill gotten gains and click the 
mouse button, once the pointer is outside the selected image, 
and drop it roughly in the center of our card. 

Adding a little colour to the picture ... 
Now we can select a background colour if we wish from 

the Options Menu on the main menu bar and change the 
colour of our card, but as we still want some control over 
what gets changed we will use thePaint Tin Tool from the 
Tools Menu instead. This tool like all the paint tools uses 
the current colour once it has been activated, so we must 
choose the current colour we want to use with the selected 
tool [e.g. the green-grey just under the white] from the 
Colours Menu. 

Simply move the pointer [now a small version of the 
paint tin icon] to any point on the screen outside the clip art 
and click on the mouse [you will also have to repeat this for 
the area just inside the mouse cord), and the screen fills with 
the current colour. We now have a card with a picture of an 
Apple //gs on a green-grey 'background' ... so what you 
may ask ... when do we get to install buttons etc .... all we 
have done so far we could have achieved with any art 
package. Read on McDuff and we will place our first button 
on the card. 

Adding buttons and sounds ... 
The first button that we will create, will do nothing more 

than play a sound once the card is viewed {in this case since 
it is the first card in the stack, once the stack has been 
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loaded}. Buttons can be made to 'do' more than one 
function at a time, but to keep things simple we will stick to 
buttons that have only a few functions. 

Like mo~! things in Hn'CrSt•Jdio, the- "Tt"'ltinn of~ huttnn 
does not require anything more from the user than the ability 
to click on the mouse button. Simply select the Add a 
Button option from the Options Menu from the main 
menu bar. Once you have selected this option you will be 
presented with the 'Button Style Menu', click on the 
invisible button option, and type in the words 'Play Sound' 
for the name of the button. Note as this button is invisible 
the name will not appear on the screen, but I still 'name' 
invisible buttons so that anyone will know what the button 
does if it needs to edited/deleted at a later date. Click on the 
OK Box {or hit the Return key} to continue. 

Because we did not choose the Advanced User option 
in the Preferences Menu, a dialog box appears giving us 
'short form' instructions on how to position and drop a 
button. Click on the Continue Box to remove the help 
dialog box from the screen and to continue installing the 
button. 

With your mouse pointer on the inside of the highlighted 
box that represents the button, click and hold the mouse 
button down and you will find the box moves as you move 
your mouse. Once you get the hang of it, move the button 
down to the bottom left hand comer of the card and release 
the mouse button. 

Resizing your Button 
At this point you can either resize your button now or later 

{if you do it later you must first select the Edit Tool from 
the Tools Menu and then click on the button you wish to 
work on to select (highlight) it}. Resizing is achieved by 
moving the mouse pointer to bottom right hand comer of the 
button, pressing and holding down the mouse button, and 
then moving your mouse to resize the button to what ever 
size you wish. I tend to make invisible buttons very small 
so that they are not accidently clicked on. For the purpose 
of the demo we will make it around the size of the Apple 
Symbol on the menu bar and place it in the bottom left 
comer. Click outside the button box to continue. 

Once you have positioned (and or resized) your button 
you are placed in the Button Actions Menu. This menu 
contains many options that define what your button will do, 
when it will do it., and what effects if any are linked to it 
etc., for the sake of clarity we will only look at those 
functions we use in each button we create. 

Adding Sound to a Button ... 
Click on the Play Sound Box and you given several 

options to choose from, via a dialog box. The choices 
consist of, taking a sound file from a Disk File, Record 
Now {via the microphone input}, or Cancel. Since we 
wish to add an existing sound file to our button we will click 
on Disk File option which puts us in the standard Apple 
File Selector menu which allows us to 'Open' the 
Elec.Harp sound file from the HS.Sounds Disk. Once 
the sound file has been loaded we are taken to the Adding a 

Apple-Bug 
Sound Item screen. 

This screen consists of a graphical representation of a tape 
recorder complete with Record and Play buttons, and 
sound level meters. To listen to the sound simolv click on 
Play, to change the volume just move the sound level 
slider, and when you are satisfied click on the Done Box, 
of if you wish to try another sound click on theCancel Box 
and try again. 

Auto Activation . 
Once again we need this sound for our demo so when you 

are ready just click on the Done box and you are placed 
once again back into the Buttons Action Menu at which 
point you can either click on the Done Box and thus 
complete the installation of a manually activated button, or 
you can add another action to the sound button we have 
created and create an automatic button. Since we wish to 
make this button auto activate we will not exit, just yet, by 
clicking on Done, but instead click on the Auto Actival . 
After Delay Box, to activate the auto activate function, and 
then change the Delay In Seconds Box from 10 seconds 
to 1. 0 second, by typing in the new number over the default 
value. Now we can click on the Done Box, and thus 
complete the installation of a simple invisible button that will 
'play' a harp sound, one second after the card is viewed. 

Seeing is believing ... 
If you wish to 'check out' the button out simply 'press' 

the button {with the mouse pointer) and the sound will play 
{you will note the pointer has changed to the Browse 
{Hand} Tool so for this very purpose}. To check the 
auto activate function just activate the Auto Activated 
Buttons option from the Preferences Menu, once you 
reenter the stack the harp sound will play after the one second 
delay. Tum the Auto Activate Buttons option off once 
again, after you are satisfied the Play Sound Button works as 
it should, and then save the stack we have created so far, as 
Simple.Stack (it would be a pity to lose what we have 
created so far because of some silly accident . 

by Kelvin Saggers 
SuperDrive Card - Apple have released a new 

card for the Apple //e, //gs, which will allow Apple // 
users to run the Apple SuperDrive { 1.44 meg] on their 
machine. 

Ethernet Card -Want to use yor Apple //e or Apple 
//gs on a Ethernet Network then Apple's new EtherNet 
Card will make your life easier. I wonder if this has 
anything to do with Apple building this function into 
future Mr.cs ... Naw just coincidence. 

GS/OS version 6.0 - Still in the testing stages as 
yet according to BBS, and other reports from the US, 
getting rave reviews, see Dales article on this, soon. 
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Animation ... 
Once you have saved your derr..o stack, "te are almost 

ready to create our 'Animation Stack'. A stack that is used 
simply to create backgrounds and clip art is cJlled an Art 
Stack, that is you are using HyperStudio only as a Art 
package to create 'cards' that contain graphics that you intend 
to use in other stacks. The cards can then be saved via the 
Screen Save option in theFile menu, and if you wish you 
can even save the stack. In most cases however Art Stacks 
are only a means to an end and as such are not normally 
saved. The Animation Stack is just an Art Stack that is used 
to create sequential pictures for use by the Activate 
Animation option in the Button Actions Menu. 

A Little Background Work ... 
Before we can create our Animation Stack we must first 

take a sample of the background we will be running the 
nimation on, so that when we start up our animation the area 

of the screen used by the animation will match the original 
exactly. For example if we had a background of the country 
side with a road and railway tracks draw in, we could use 
parts, or all of this background to animate a plane, truck, 
train, or any number of other objects on it. 

The type of animation we are going to create is a very 
simple one but uses the same principles as you would use to 
create complex animations. This simple type of animation 
could be just as easily accomplished by creating more cards 
on the demo stack and then 'flick' through them via a series 
of auto activated or manual buttons, in fact you would 
probably be better off doing this for two screen animations 
like 'push in' buttons (HyperSilly Stack), and breaking menu 
bars (Apple-Q Stack) (both of which are available on demo 
disks in the club's software library). For multi screen 
animations however you are much better off using the built in 
animation options. 

Saving Screens 
OK, let get this show back on the road. Whilst you still 

.• ave the demonstration stack we have just created in your 
computer's memory, use the Save Screenoption from the 
File menu to save an image of Card 1. Save this screen 
image (card) as Screen.l. Now that we have 'captured' 
an image of our stacks background we can use the New 
Stack option from theFile menu to close our demonstration 
stack ( you will be prompted to save the stack, if you have 
not already done so ), and create a new stack as we did 
before, this stack will become our Animation Stack. 

Again we start off with a white background on card 1, this 
time however we are going to place a ready made background 
onto our stack. Using the mouse pointer select Load 
Background from the File Menu and Open the file 
Screen .1, this will place an image of the background from 
our demonstration stack onto the background of card 1. 
1\olc: i he IJurtons are only graphic representauons oi the 
origmals and as such do not 'work', you can transfer cards 
complete with functioning buttons etc., but not via this 
method. 
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Text as a Graphic ... 
Follow the simple steps bellow to type the following text 

on the drawing of the Apple Ilgs monitor's screen: 

IIGS is 
the best 

[1] Select the Text Style option from Option Menu, 
and choose the Shaston 8 point plain Font. 

[2] Select either Set Text Colour and then black from 
theOptions Menu or the colour black directly from 
the Colours Menu to set the current colour. 

[3] Select the Text Tool from the Tools Menu and 
move the mouse pointer [which now looks like an I} 
onto the top left hand side of the monitor on your 
screen and type in the words as shown above so that 
they sit in the center of the screen, or as close as 
possible. 

Creating New Cards ... 
You should now have a picture of an Apple //GS with the 

words 'IIGS is the best' on it's screen. We could now 
create 13 cards identical to this one, and we can do this is 
several ways. Using the Copy Card and Paste Card 
options from the Edit Menu we could quickly create as 
many new cards as we please complete with buttons if any 
are present. 

The other method we might have used would have been to 
go into the Apple Menu and deactivate the Erase 
Background on New Card option. Once this option is 
deactivated every time you selectNew Card option from the 
Edit Menu you would create a card with the same 
background that uses up no more memory than before as 
HyperStudio 'shares' the original background with all the 
new cards you created. 

Creating the Animation Screens . 
Either way we would now have a stack with 13 cards with 

the same image on each, and we could then delete a letter 
from each card so that the words would appear to type them 
selves on the screen if we wished to flip thru the cards 
quickly. But we are not going to do that at all, because all 
we need to do for this simple animation can be done on the 
one card we already have. Again we must take a 'snap 
shot' of the screen via the Save Screen option and call it 
Words.l4. 

As 'text' placed on the screen via the Text Tool is 
nothing more than a graphic image it must be operated on via 
the normal Paint Tools, not the Text Tools. The simplest 
way to 'erase' each letter in such 'text' is via the Eraser 
Tool, but as this text is so small we should therefore use the 
Magnifying Tool from the Tools Menu, 1v .tiiow ~~~ iv 
work in finer detail. 

After we have selected this tool we can then move our 
mouse pointer [ now a rectangle } over the letters we wish to 
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'erase', and then activate it simply by clicking the mouse 
button. 

The card on the screen is now replaced by the magnified 
image cf th! area we !lave just selected, and using the mouse 
pointer we can now 'wipe out' the 't' in the word 'best', a 
pixel at a time { a normal sized image of the area you are 
working on is located in the left hand comer and allows you 
see what you are doing as the magnified image is altered ] . 

Once you have finished just click on the full sized image at 
the top left of the screen to exit from the magnified { Zoom, 
Fatbits ] screen mode. 

Now the letter has been removed, once again save the 
screen but this time with the file name of Words.l3, repeat 
this operation until all the 'letters' and 'words' have been 
deleted. You should now have 14 screen files called 
Words.! to Words.14, the last image will be a blank screen 
{ Words.l ] save this screen also as Words.15, this blanks 
the screen again after the 'animation' is complete. At this 
point we no longer need the animation stack so we can load 
our original demo stack back in via the Open Stack 
command in the File menu. 

Placing the Animation onto the Card ... 
We are now finally ready to actually create the animation 

on our card, once again we will use an invisible button to 
activate the 'action', but this time it will be a 'manual button' 
that will be activated by the user of our stack. We will hide 
an invisible button over the image of the Apple //gs keyboard 
so that if anyone should click on that part of the screen the 
words 'IIGS is the best" will appear on the image of Apple 
1/gs monitor. OK so it's not an award winning idea, but it 
will do for the purpose of our simple demonstration. 

Again we use the Add a Button option from the 
objects Menu to create an invisible button called 'animate 
words', following the same method we used to create the 
first button on our card. This time however we are going to 
position our button to sit over the graphic image of the 
keyboard and size it to suit. Once you have achieved this 
simply click outside your button to drop it, and enter the 
Button Actions Menu. 

Next you must 'click' on the Activate Animation box 
to install your animation. You will then be placed in the 
standard file selector box in order to select your animation file 
sequence { the one we just created ] , which in this case is the 
sequence that starts with the file Words.!. Open 
Words.!, and once you have done so, you will find that 
you have again been placed back on the card you started 
from, so that you can now position and resize your 
animation. In most cases the you will have to use the hand 
pointer to move the image around inside the animation 
window so that the screen outline is in view. You should 
then resize the window so that it covers the image of the face 
of the monitor and position it so it matches the original. 

Once you are satisfied, you can then click outside the 
animation window and thus drop it to continue the 
installation, if all has gone well you should now see the 
words "creating animation" appear on your screen. If the 
animation has been installed successfully you will find your 
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self back in theButton Actions Menu. In most cases any 
failure is due simply to a lack of enough memory to complete 
the operation, as you will be informed, via a dialog box if 
such is the '.'~.:~. 

Repeating the [x] Rated Loop ... 
At this stage we could simply click on the Done Box but 

as we only wish to have the 'animation' occur once every 
activation { button press ) we must first change the Repeat 
Count to 1 { leave the Rate at the default level or increase 
it, if you wish the 'printing' to appear on the screen at a 
slower rate ] . Now we can click on theDone Box and our 
animation installation is now completed. 

Testing and Finishing the Stack ... 
To prove that all is well, just move the mouse pointer ( 

which should have changed to a hand ] over the image of the 
keyboard and click on it. The animated letters should nc< 
appear on the screen, and the screen should blank out again 
when fmished (this is the reason that your start and end files 
contain the same graphic information]. 

As I said when we started, the stack does not do much, 
and you might like to add a 'Quit' or 'Home' button to round 
of the stack before you fmish it. I always hide the menu bar 
on all the cards in my stacks bar the last one with the Open 
Apple M ( Hide Menu ) command, before I save any of 
my stacks. I also always create a card that does nothing at 
the end of each stack ( the one I don't hide the Menu Bar on 
), so that I can just hit the Open Apple 9 key sequence ( 
Goto Last Card ] to jump out of any auto activated cards 
in the stack, whenever I want to work on the stack. Normal 
users of my stacks never see this last card as it is never 
pointed to by a button (unless I hide a small one somewhere 
as a backdoor). If you wish to, you can create a card like 
this simply by selecting theNew Card option from theEdit 
Menu from the last card in your stack, in this case as we 
only have one card the new card will be Card 2. 

We have all but completed our stack. To do so we simpl}l 
select thePreferences Menu from theApple Menu, then _ 
activate the Auto Activated Buttons option and then to 
exit the menu click on OK. To finish our stack, select 
Hide Menu from the Options Menu ( or Open Apple 
M ), and then Save Stack from the File Menu ( or 
Open Apple S ] . That's all folks ... 

ETH NED ... 
Well I hope this was of some help to someone, I had 

intended to create a much more complex stack but the 
logistics (and space} required to put the information on 
creating such a stack onto paper made compromise almost a .. 
certainty. I feel such things are better left to meetings or 
individual enquiries. So if you have any comments or 
questions feel free to ask, remember HyperStudio was 
designed for people to be able to 'play around' with, so 
experiment, this has always been and always will be the best 
way to learn, and HyperStudio makes the process so 
painlessly easy. 
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By John Finch. 

Since I have been raving on about System 7 for two 
months now, it is about time I reported some of the bad 
things I have found. Of course the main problem with 
System 7 is its size, both on disk and in memory. As I type 
my system is taking up just a tad under 1.5 Mbytes of RAM 
whilst the system folder on my hard disk is pretty close to 
3.5 Mbytes. Hey Ho for the old days of System one where 
you had the system folder, MacWrite, MacPaint and a few 
files all on one 3.5, 400 Kbyte floppy! Mind you, the 
functionality has gone up a bit as well. 

As to the other problems with System 7, It does slow 
u1ings down a bit. My first encounter with System 7 was a 
beta version and it was slow; however, now that I have the 
releas~ version ru~ning it is much better and the slowing 
down IS not so noticeable. The biggest wait is for the thing 
to boot in the first place. Other problems are that some of 
my f~vourite progr~s will not run. I have solved that by 
keepmg a System 6 d1sk handy, but it is a down side. 

But now to the bugs. You know what they say about a 
software upgrade? It is just a way of swapping old bugs for 
new! Anyway the two I have found are: 

C~pying folders from disk A to disk B. Very 
occasiOnally the folder will not copy with the error message 
"You cannot copy a folder to itself' - mind you this is 
copying to a blank disk! Re-naming the folder solves the 
problem. 

The other "bug" I found when trying to copy Stuffit files 
lhat had been split. The error message was that "the file 
, auld not be copied due to a disk error." The disk was 
tested this way, that way and every-which-way and still came 
up squeaky clean every time, yet I could not copy the file. 
Booting with System 6 and no problems, files copied like a 
dream. I repeat that this was only with split Stuffit files, as 

by Kelvin Saggers 
The following is a short summary of each of the positions 

of the management committee that still vacant, as of the time 
of printing. 
Vice- President: 

Tn :~r.t nn hehalf of any other officer in their absence and 
ro ,Jig:wize demonstn.t~; .. J:s .,,~." .. · •. _1,. .d ,. ::t: int..:rest 
groups to maintain a sens:: o! li;" :i• • , ··!thin . ."1e 6roup. 
Secretary: 

To record minutes of meetings and attend to all incoming 
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ordinary Stuffit files copy without a problem. 

We all grumble at our Mac from time to time, and say, 
why can't such and such a program be more friendly? I do it 
constantly, or rather I did until recently. I now find myself 
at work learning how to tame a VAX mainframe computer. 
You know the difference in friendliness between the Mac and 
MSOOS? Well the VAX is the same distance again- in the 
other direction. I never thought I would see the day when I 
thought MSDOS friendly! Who ever heard of a disk drive 
called $1$DIAO: ? Miss the colon off at your peril. Yuch. 
Every night when I get home the first thing I do is to hug my 
Mac and have a quiet cry. 

The Apple-Q Macintosh public domain library has grown 
again. I fight a constant battle against fmding floppy space 
for the programs that are always threatening to bust my hard 
drive at its seams. It is a bit like a magic hom of 
Cornucopia, the more files I take off my hard drive, the more 
files seem to just materialise and refill the space! 

However, the club now has another 25 or so disks of new 
stuff- and that includes topping up some of the old disks that 
were not quite full. I have not really had a chance to evaluate 
much of the software but some of it looks pretty good. 
Much of it is updates on old favourites, new versions and 
bug fixes. 

There are lots and lots and lots of INITS - you know, 
those little programs that you put in your system folder to 
make your other programs bomb! One of these that has me 
fascinated is a pair of eyes. Just two little circles with blobs 
in that sit on the menu bar and watch the mouse pointer on 
your screen. The eyes follow it around the screen, but if 
you do not move the mouse around for a while then they go 
to sleep. No program can stop them from popping up and 
watching what is going on. Not very exciting - or useful -
but fun (they do say that little things please little minds!). 

I have created a new dLibrarian file of the library and it is 
available at the meetings, by post, or on Kelvin's BBS -The 
Phoenix (07) 800-4660 in the Mac Utility area - I may even 
put it on the club BBS IF I can log on long enough to 
download it { Note: I have already placed it there -Ed } . 

and outgoing correspondence. To organize fund raising 
ventures to ensure a continued flow of funds. 
Editor: 

Organize the production of the groups publication to 
enable distribution to members within the time limits set each 
month. Liaise with printers to ensure timely publication. 
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suitable material. 
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programs in a manner suitabk fot tl.e safe kei:l'ing c( i,;e 
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library. Write reviews where appropriate for the newsletter. 
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by Graham Black 
Over the past few years, it has been good to see so many 

new faces making themselves known at the Open Day 
meetings. I receive phone calls on the average of about two a 
week,. concerning AppleSoft BASIC. There are a lot of 
people out there who are buying their first computers, and 
know absolutely nothing about them. So once again I have 
put my fingers to the keyboard and worked out some 
interesting little routines that might help to explain the 
workings of a BASIC program to the novice user. 

I have a //gs, and when I write programs, I use the 80 
column mode exclusively, and I am including all the 
appropriate 80 column codes as well, and the explanation for 
these can be found in your 80 column card manual (1/eJ/cJ/gs 
only). There are no standard 80 column codes for the 
Europlus. 

When assigning variable names, try to let the variable 
mean something to you, so that when you see a variable in a 
program, it means something, without having to look it up, 
i.e. SL = slot, FL = flag, AN$ =Answer [D$=CHR$(4) 
<control-D> used for DOS commands], PW$ =Password, 
BL$ =Bell, NA$ =Name, AD$ =Address, PH$ =Phone, 
AC$ = Area Code, UL$ = Underline, SP$ = Space, DO$ = 
Dot, etc. These are some of the variables I use, and I can tell 
what they are at a glance. It makes for much easier reading 
of a program, when you can instantly identify a variable 
name. 

Following is a list of some common BASIC subroutines 
that you can type in and try out for yourself if you wish. I 
hope you find them useful. 

Turn on a Slot ... 
Here are a couple of command lines you can use instead of 

the standard PR# ... to tum your printer on and off, from 
within a program. 

Tum on a slot (use in place of PR#1, where SLOT= 1) 
100 Poke 54,0: Poke 55,192 +slot 

Tum off a slot (use in place of PR#3. Never use PR#O in 80 
80 col. mode.) 

200 Poke 54,240: Poke 55,253 

Centre a line of text ... 
There is always the occasion when you want to centre a 

line. You could always count the letters in the string and 
then TAB to the appropriate position, but why not let the 
computer do it for you. 

10 HOME 
20 LW = 80: REM Page width (characters per line) 
30 D$ = CHR$(4): PRINT D$"PR#3": REM Switch 
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on 80 col card 

100 B$ ="I am in the centre" 
110 GOSl'B 19090 
999 END 
19080 REM CENTRE Routine 
19090 VTAB 12: Poke 1403,(LW-LEN (B$))/2: 

PrintB$ 
19100 RETURN 

Note: If you do not have an 80 column card and are 
working in 40 column mode, then change line 20 to L W = 
40, and delete line 30. 

A Pause Without Cursor ... 
A Pause routine can be a very important part of any program. 

Here is one that I use all the time. It can be added to the 
lines you have already entered. 

30 D$ = CHR$(4): PRINT D$"PR#3": REM Switch 
on 80 col card 

40 CL$ = CHR$(26): SI$ = CHR$(15): SO$ = 
CHR$(14) 

50 VTAB 10: B$ ="This is a test": GOSUB 19090 
120 GOSUB 19010 
999 END 
19000 REM Any Key to Continue 
19010 VTAB 23: POKE 1403,1: 

PRINT SI$" Any Key to Continue - <ESC> to 
Quit ";SO$;: VTAB 20: Print 

19020 PE =PEEK (49152): ON PE < I27 GOTO 19020: 
POKE 49168,0: PE = PE- 128 

19040 VT AB 23: PRINT CL$: VT AB 23 
19050 RETURN 

Wait for input. .. 
A WAIT routine, waits for input without a cursor showing 

on the screen. I have always disliked seeing the cursor, 
waiting for input, so I always use this little routine: 

40 SI$ = CHR$(15): SO$ = CHR$(14):REM 
NORMAL & INVERSE 

50 VT AB I 0: PRINT "This is a WAIT test" 
200 GOSUB 18010 
999 END 
18000 REM WAIT 
18010 VTAB 23: POKE1403,10: 

PRINT SI$;"Any Key to Continue"; SO$;: 
18020 WAIT -16384,128: POKE -16368,0 
18030 VTAB 23: POKE1403,10: 

PRINT LEFT$ (SP$,20); : REM 20 blank spaces 
18040 RETURN 

Onerr Goto ... 
An ERROR Routine is also very important to have in your 

program, and this one will tell you where the error occurs. 

15 ONERR GOTO 19120 
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19110 REM ERROR Routine 
19120 ERR = PEEK(222):X = PEEK(218) + 

PEEK(219) * 256 
1~130 POKE 216,0 
19140 PRINT: VTAB 23: 

PRINT ''Error "ERR" Encountered in line"; X: 
VTAB1 

19150 STOP 

To see the full effect of the error routine, enter the next line 
and run the program. The program will crash, and the error 
routine will take over. 

25 QWERTY 

Now delete line 25. To do this, just type 25 and press the 
RETURN key. 

Jr the BUG Hunter ... 
Here is something for the RUG-HUNTER to ponder over. 

Enter this little beauty exactly as shown. To get it up and 
running, DO NOT type RUN. Type GOSUB5 from the 
keyboard and enter ERR at the input prompt: 

5 INPUT A$: RETURN 
100 TEXT: HOME: VTAB 10: 

PRINT "APPLESOFf ERROR" 

Now delete line 100 by typing 100 and press RETURN and 
try again. Maybe Graham would like to explain how 
this happens in the next issue, to aid those who 
might have a little difficultly in tracing what 
causes this to occur - Ed. 

Concatenation ... 
String manipulation is a very important part of basic 

programming. This is one method used in a data base 
(.>rogram for storing information to disk. 
. Let us say, that for our files, we require NAME & 
PHONE NUMBER. In our program, we INPUT this data in 
three separate operations. First we require the name, so we 
call our variable NA$. Next we require the area code, and 
we will call this AC$. Last but not least, we require the 
phone number itself, and this we call PH$. 

We now must decide how many letters we will allow for 
each string. Let us assume that no name will exceed 25 
characters in length, and that the phone number will contain 
no more than 14 characters, including area code and 
separators. When the data has been entered, we must check 
to make sure that it does not exceed the limit, and that it is 
exactly th~ right length, so that we will always know exactly 
where to fmd the data from within the string. I always insert 
a space ~twee~ each string as I assemble the main string. By 
domg this, Iookmg at the string, I can see exactly where each 
component part is located. This method also sets things up so 
that the string can be printed 'as-is'. The string ST$ will 
now have a length of 40 characters. Our strings will look 
something like this: 
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NA$ = " ......................... " 
AC$ = "( ... )" 
PHS = '' ... -.... " 
ST$ = ......................... ( ... ) 

10 HOME 
20 BL$ = CHR$(7): REM Bell 
30 FOR I= 1 TO 79: SP$ = SP$ +" ": next I 
90 REM Enter Name as NA$ 
100 VTAB 1: INPUT" Name: ";NA$ 
110 REM - If the length of NA$ is greater than 25 
120 REM- then GOTO 100 and enter it again. 
130 IF LEN (NA$) > 25 THEN 100 
140 REM- If the LENgth ofNA$ is less than 25 then 
150 REM- add a space to NA$. 
160 IF LEN (NA$) < 25 THEN NA$ = NA$ +II": 

GOTO 160 
170 VTAB 3: INPUT" Area Code: ";AC$ 
180 REM - If the length of AC$ is greater than 3 
190 REM - then GOTO 170 and enter it again. 
200 IF LEN (AC$) > 3 THEN 170 
210 REM - If the LENgth of AC$ is less than 3 
220 REM - then add a space to AC$. 
230 IF LEN (AC$) < 3 THEN AC$ = " " + AC$: 

GOT0230 
240 REM- AC$ is now the correct LENgth so now 
250 REM- add the brackets "( ... )" 
260 AC$=1"+AC$+1" 
270 VTAB 5: INPUT "Phone Number: ";PH$ 
280 REM - If the LENgth of PH$ is greater than 7 
290 REM -then GOTO 270 and enter it again. 
300 IF LEN (PH$) > 7 THEN 270 
310 REM - If the LENgth of PH$ is less than 7 
320 REM - then add a space to PH$. 
330 IF LEN (PH$)< 7 THEN PH$ = " " +PH$ 
340 REM- Insert"-" in PH$. 
350 PH$= LEFf$(PH$,3) + "-" + RIGHT$(PH$,4) 
360 REM - Display all 3 strings so they can be 

checked 
370 HOME 
380 VTAB 8: HTAB 1: PRINT NA$ 
390 VTAB lO:HTAB 15: PRINT AC$;" ";PH$ 
400 REM - Confirm that all the entries are correct 
410 REM - before the fmal assembly of the string. 
420 GOSUB 18010: REM Confirm (YIN) 
430 REM - If the data is not correct then go back 
440 REM - and start again. 
450 IF AN$ = "N" OR AN$ = "n" THEN 10 
460 REM - It is now time to assemble the 3 strings 
470 REM- with a space between each one and call 

themST$. 
480 ST$ = NA$ + II " + AC$ + " " + PH$ 
490 REM -Display ST$. 
500 VTAB 12: HTAB 1: PRINT ST$ 
510 END 

18100 REM Confirm (YIN) 
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18110 VfAB 23: HTAB 13: 

PRINT BL$;"Confmn (y/n) ";: GET AN$ 
18115 REM - Allow both upper and lower case input 
18120 IF AN$<> "Y" AND AN$<> "N" AND AN$ 

< > "y" AND AN$<> "n" THEN 18110 
18130 VfAB 23: HTAB 13: PRINT LEFf$ (SP$,14);: 

REM 14 spaces 
18140 REM - The semicolon is necessary to stop the 

screen 
18150 REM- from scrolling up one line. 
18170 RETURN 

String Manipulation ... 
String manipulation is a very useful tool to have at your 

fingertips. If you can master string manipulation, then you 
are well on the way towards mastering the AppleSoft BASIC 
language. Using the scale below, you can count the number 
of characters in the string, and their relative positions within 
the string. 

I 00000000011111111112221 
1234567890123456789012 

A$ "COMPUTER.OF.THE.FUTURE" 

1
000000000 I 
456789012 

Z$ = MID$(A$,4,9) • "PUTER.OF." 

The 'C' is in position 01, 'M' is in position 03, 'F' is in 
position 11, and 17, and 'H' is in position 14, etc. To get 
the first five characters of A$ and assign them to L$, your 
formula will be: 

L$ = LEFf$(A$,5) 

To pull out the word '.of.' and assign it to the string M$, 
you count from the left side of the string to the first letter 
required, which in this case is the 9th position. Next you 
must count the number of characters you require. In this case 
4 characters are required. Your formula will be: 

M$ = MIDS(A$,9,4) 

You must separate the components of the formula with a 
comma, or you will be presented with SYNTAX ERROR 
when you try to run the program. 

Enter the following code and try it for yourself: 

10 REM- String Manipulation 
20 REM 
30 REM - With the use of 
40 REM - LEFf$( 
50 REM - MID$( 
60 REM -RIGHT$( 
100 HOME 
110 A$= "Computer.of.the.future" 
120 REM- Take the first eight letters from the left 
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130 REM - hand side of A$ and assign them to L$ 
140 L$ = LEFf$(A$,8) 
150 REM- Take the middle 81etters from the 9th 
160 REM - position and assign them to M$ 
170 M$ = MIDS(A$,9,8) 
180 REM Take the first six letters from the right hand 
190 REM - side of A$ and assign them to R$ 
200 R$ = RIGHT$(A$,6) 
210 REM- Print the string as A$ followed by the new 
220 REM - strings L$ M$ R$ 
230 PRINT A$ 
240 PRINTL$ 
250 PRINT M$ 
260 PRINTR$ 
270 REM -Now print a blank line 
280 PRINT 
290 REM- Now take the strings and print them in the 
300 REM -reverse order 
310 PRINTR$ 
320 PRINT M$ 
330 PRINTL$ 
340 PRINT A$ 
350 REM - Now re-assemble the string in reverse 
360 REM - order and call this new string 8$ 
370 8$ = R$ + M$ + L$ 
380 REM- Now print the new string preceded by 
390 REM- a blank line 
400 PRINT 
410 PRINT BS 

That's all there is to it.. ... simple isn't it? That is all for 
now, and as I said before I hope this is of some help to those 
of you who are just starting to find your way into AppleSoft 
Basic programming. 

Please forward any questions on this article to 
the author either via the Help line number listed at 
the front of this issue, a letter, or talk to him 
direct at the Open Day meetings - Ed 

'II'll~ Jll!ln~:r:ru~na®m~il J..®~~ ffim:rull!l~:r 

lF~ll!l CilMil> ~ 'Il'®~:J®~ JJ~JP~:D 

Has offered to swap optional Lode runner 
screens on a 1 to 1 basis with members of 
Apple-Q. 

They have 1500 different Apple ][ Lode 
Runner Screens some of which include screens 
for Regular L.R. {150}, Champ L.R. {50}, 
Big Red AC L.R. {150}, French L.R. {150}, 
and Fujionkyo L.R. {101}. 

For further details contact Ian Millar at the 
~ :-, ::'t :i~Cl:t~r;;; :1-:: ! :;ha:: ~r - .......... : .... ,., .~.. .... 

lllu;mativ•l Ol!tO the clubs HardC;•;J_I ,:t;, _,. , <•. 

so that all Hlemucr~ have access to il. 
- Kelvin 
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We are celebrating Apple-Q's Tenth Birthday with the 
biggest release of new disks - 10 in all. See Jeff or myself at 
the Software Library table at the next meeting or order by 
mail. Order form appears on the inside back cover of this 
issue. The prices are as follows: 

Type No Disk With Disk 
5.25 mch $4.00 $5.00 
3.5 inch $5.00 $8.00 

GS/OS Utility Disk #II 

Disk Witch v2.2.3 - This program is a CDA which is 
·installed during the startup of your computer. It allows for 
'the following file utilities to be performed from just about 
anywhere (while using GS/OS or ProDOS 8): Volume 
Display, Directory Display, Attributes- Change Attributes of 
files/directories, Deleting of files/directories, Renaming of 
files/directories/volumes, Formatting/Erasing Disks, Copying 
files, Making subdirectories, Reading text/AppleWorks files 
& Changing Prefix's. This is the latest version. 

Lithium Grease vl.O -An amazingly simple NDA that 
saves and loads the contents of the IIgs Battery RAM to a 
disk file. It loads and saves Apple's Battery RAM filetype 
(type $5A, auxtype 2). Includes source code. 

RunQ v1.31 - RunQ is a program-launching utility that 
allows you to instantly switch from one application to 
another, without reentering the Finder. Because it remembers 
the location of the installed applications, it can be used to 
easily access your programs without going through the 
hierarchy of your disk structure. This program is very 
similar to the commercially available program OnCue™ for 
the Apple Macintosh, which in fact gave me many of the ideas 
of how to design my program. This is also the latest 
version. Like OnCue, it now displays an icon in the right 
hand side of the menu bar. This version also allows you to 
launch Basic and Binary files. 

SAP v0.5b - SAP is an animation program. If you have 
ever used Take-!© Baud ville, or Art & Film Director© Epyx, 
then you are already familiar with this program. To put it 
simply, SAP lets you create movies and put together 
animations on your GS. This program was somewhat 
modeled after Take-I, so if you have used this program you 
shouldn't have much problem adapting to SAP. Requires a 
GS with at least 1.25 megs of memory, paint program 
capable of saving $CO pictures & a text editor. 

SuperDataPathTM v2.00 - SuperDataPath does three 
things for you ... 

1. Transparently sets the default (original) data directory 
for any and all Apple Ilgs desktop application (Sl6 files) that 

13 
you wish. The default data directory is the one that is shown 
first when you select 'Open' from the Application's 'File' 
menu. This feature is called FastPath. 

2. Adds a folder icon to Open file dialog boxes that, 
when clicked, displays a pop-up menu of all you FastPaths 
so you can quickly switch to them. This feature is called 
SuperPath. This Power Tool is an optional feature of 
SuperDataPath. Over 2,000 paths can be set up in this 
manner, allowing you to quickly access various folders on 
your system. This is an invaluable tool, particularly for 
hard disk users. 

3. Fixes a minor bug in the current version (System Disk 
5.0.4) of Apple's Standard File Toolset. This version 
replaces DataPath. 

SuperView v2.0 - SuperView displays 3200 colour 
graphics on your GS screen - yes 3200 colours on the screen 
at the one time. Super View also allows you to convert 3200 
colour pictures to Apple's standard file formats. This 
version also fixes a major bug with version 1.2. Pictures 
converted with version 1.2 can be fix with this version. A 
3200 colour picture is included. 

The Snail v2.00 - The Snail is a SCSI tape backup 
program for GS/OS. It will backup any disk onto any SCSI 
tape drive recognised by Apple's Apple II High Speed SCSI 
card. The input disk must be recognised by GS/OS, and 
have a fixed block size of 512 bytes. Whether or not the 
device is formatted for ProDOS doesn't matter, as long as it 
can be accessed at the block level. Requires an Apple Ilgs 
with GS/OS, an Apple II High Speed SCSI card, and a SCSI 
tape drive which the card will recognise. 

_ ZZ Copy v2.10 - Z:Z Copy is a fast disk copy program 
like Photonix. Like the Shareware version of Photonix, you 
must boot the disk to run it. Here are some of the new 
features: Optimize mode (beach combing), New verify 
routine, New optimized reading routine, Files infos, Graphic 
bitmap, Exchange drives, Brick Out game, Transparent anti­
virus mode (detects viruses - Load Runner - 2001 
Odyssey & Starfighter II) & Screen Saver (the delay is set to 
1 minute). ZZ Copy may be used to copy Macintosh 
Disks (400 or 800k) in the same way as the Ilgs disks (the 
fastcopy options are available too). It also works on ROM 
03 machines and Z:Z Copy doesn't write any more 
information in your Battery RAM. 

Boucing Bluster 

Here is the Shareware version of Arkanoid. And like 
Arkanoid II it come complete with a Construction Set to ·. 
design your own screens. Many screens are included on this 
two disk set. Because Bouncing Bluster does not work 
under System 5.x, it comes on a bootable disk (with System 
4.0). Please read the file "Read This" before running the 
program. The Construction Set comes with full 
documentation. The two disk set sells for $8.00 on your 
disks or $14.00 including disks. 
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Ace Sounds 

A while back we released five disks of digitized sounds to 
play on your Apple Ilgs. Since then, we have received 
megabytes of digitized sounds. To save space, the sound files 
on this disks have been compressed using Apple's ACE 
toolset. Now the original five have been expanded to seven 
disks with over 1 0 megabytes of uncompressed sound files. 

You can decompress these sounds using AudioZap 
(GS/OS Utility Disk #10) or Acer (GS/OS Utility Disk #6). 
Some of these sound files require 1.25 meg RAM to 
decompress and play. The only exception is the sound 
"Jetsons.Ace" on the Ace Sounds Disk #5 - you will 
require at least 1.5 meg of RAM. If memory is a problem, I 
recommend that you use AudioZap to decompress the flies. 

Ace Sounds Disk # 1 

Assorted Sounds: Alert.Ace, Applause. LAce, 
Applause.2.Ace, Baby.cough.Ace, Baby .Crying.Ace, 
Baby.Laugh.Ace, BellAce, Big.Ben.Ace, Bike.Horn.Ace, 
Boing.Ace, Boings.etc.Ace, Boom.ooo.Ace, 
BreakGiassl.Ace, BreakGiass2.Ace, BreakGiass3.Ace, 
BreakgGass4.Ace, Brook.Rpt.Ace, Bugle.Ace, Cackle.Ace, 
Carignition.Ace, CashRegistr.Ace, Cavalry1.Ace, 
Cavalry2.Ace, Choir.Ace, Click.Ace, Cosmic.Ace, Cry .Ace, 
Da.da.da.Ace, DishCrash.Ace, Door.Beii.Ace, 
DoorKnob.Ace, Dopes.Ace, EjectBleugh.Ace, Explode.Ace, 
Explosion.Ace, FactoryWhis.Ace, Finger.Snap.Ace, 
FT APresents.Ace, Future.Ace, Game.Over.Ace, 
GrandadOoc.Ace, Grossness Ace, Guy Rice Voic.Ace, 
Helicopter.Ace, Howi.Ace, Jack.Harnmer.Ace, Jetl.Ace, 
Jet2.Ace & Joke.Ace. 

Apple-Bug 
Small.dogAce & Whale.Ace. Music: Beethoven.5.Ace, 
DramaMusic 1 Ace, DramaMusic2.Ace, Funky .Bells.Ace, 
Guitar Music. Ace, Hallelu jah.Ace, Orchestra 1.Ace, 
Orchestra2.Ace, RoadNoWhereAce, TinkleMusic.Ace & 
Tune.Ace. Instruments: Violin.Ace, Banjo.Ace, 
Bass.Ace, Bass.Guitar.Ace, CowbeiiAce, 
CrashCymbal.Ace, CymbalAce, ElectriHarp.Ace, 
Aute.Ace, Harmonica.Ace, Harp.Up.Ace, High.Hom.Ace, 
JawHarpAce, Korg.Ace, Marirnba.Ace, Scale.HighAce & 
Sitar.Ace.Film and TV: Batrnan.Ace, CartoonVoicAce & 
Rude.Ace. 

Ace Sounds Disk #4 

Film and TV: Addarns.Ace, Beverlyhill.Ace, 
Coke.is.It.Ace, Come.on.Ace, DasdafacJac.Ace, 
Dont.Deact.Ace, Dont.Worry.Ace, Dorothy.Ace, 
DuzNotCompu.Ace, Aintstones.Ace, FranklyMyde.Ace, 
Freeze.Ace, Get.Ready.Ace, GM.Vietnam.Ace, 
Happened.Ace, Happy .Birth.Ace, HelloComput.Ace, 
I.am.Sorry.Ace, I.like.It.Ace, Jungle.Geor.Ace, 
Kiss.Me.Ace, Looney Tune 1.Ace, LooneyTune2.Ace, 
Make.My.Day.ke, Malfunction.Ace, Marvin.Ace, 
MaxHeadroom.Ace, MGM.Lion.Ace & Missionimp.Ace. 

Ace Sounds Disk #5 

Film and TV: Jetsons.Ace, My.Fault.Ace, Ni.Ace, 
NiceSoftwar.Ace, Panther.Ace, Pile.Ace, Play.a.Game.Ace, 
Rocky.Ace, Secret.Word.Ace, Something.Ace, 
Superman.Ace, Thats.aii.Ace, Thats.Nice.Ace, 
TwilightZnl.Ace, TwilightZn2.Ace, UnderArrest.Ace, 
Waming.Ace, WhataYaWantAce, WhereMoney.Ace & 

.__ ___ A_c_e_S_o_un_d_s_D_is_k_#_2 ___ ___.·1 You.Idiot.Ace. 

Assorted Sounds: IBM.Selectr.Ace, Intro.Ace, 
Klank.Ace, Knock.Ace, Laser.Ace, Laugh.Ace, 
Laughter.Ace, Mamee2.Ace, NewAiert.Ace, Ouch.Ace, 
PassprtSpan.Ace, PassThatOvr.Ace, Plucked.Hit.Ace, 
Refs.Whisti.Ace, Sawing.Ace, Scratch.Ace, Scream.Ace, 
SenioritaSp.Ace, Ships.Hom.Ace, Short.Driii.Ace, 
Short.Phase.Ace, ShortTruckH.Ace, Shotgun.Ace, 
Slam.Ace, SmaiiEngine.Ace, Snake.Ace, Space.Gun.Ace, 
Splash.Ace, SquishAce, Stair.Bonk.Ace, Static.Ace, 
Swamp.Ace, Swords.Ace, Ticking.Ace, Timer.Ace, 
Tink.Ace, Truck.Hom.Ace, Twinkly.Ace, Ugh.Ace, 
Vanish.Ace, Voices.Ace, Waming.Ace, Waterfali.Ace, 
Whistle.Ace, Whoops.Ace, Wipeout.l.Ace, Wipeout.2.Ace 
& WooshAce. History: LibyaDFight.Ace, 
Not.a.Crook.Ace, One.Giant.L.Ace, SpaceShutti.Ace & 
STS.29.Ace. 

Ace Sounds Disk #6 

Bill & Ted's Excellent Adventure: BeExcellent.Ace, 
Dust.Wind.Ace, Iron.Maiden.Ace & Sixty.Nine.Ace. 
Peewee: Peewee.Know.Ace, Peewee.Make.Ace, 
Peewee.Ment.Ace & Peewee.Spea.Ace. 2001 A Space 
Odessy: FunctioningAce, Hai.Message.Ace, 
Hai.Moment..Ace, Hai.Nothing.Ace, Hai.Sorry.Ace, 
Hai.Stop.Ace, Human.Error.Ace, No.Purpose.Ace, 
Operationai.Ace, PodBayDoors.Ace & Sorry.Dave.Ace. 
Star Wars: Been.Waitin.Ace, Close.Down .. Ace, 
Strike.MeAce, The.Master.Ace & Where.Do.Ace. 
Terminator: III.Be.Back.Ace & YourMoveCre.Ace. 
Stooges: Curly.Ace, Curly.Victrn.Ace, Nanana.Ooof.Ace, 
Nyuk.5.Ace, Oooooo.Ace, Stooges.Ace & 
TryToThinkAce. 

~-----A __ ce __ S_oun __ d_s_D_i_s_k_#_3 ______ ~1LI _______ A~c~e~S~o_u~nd~s~D~is~k~#7~----~ 
Animals: BarkingdogsAce, BirdCall.Ace, Birds.Ace, 
CookooAce, Duck.Ace, Elephant.Ace, LionAce, 
Monkey1.Ace, Monkey2.Ace, Parrot.Ace, Puppy Ace, 

Star Trek TNG: Beam.Down.Ace, Beam.Up.Ace, 
Cargo.Door.Ace, Communicatr.Ace, Computer.Ace, 
Door.ChimeAce, Door.Open.Ace, Haii.Signal.Ace, 
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Hand.Phaser.Ace, Leave.Warp.Ace, Photon.Torp.Ace, 
Red.AiertAce, Ship.Phaser Ace, Tricorder.Ace & 
Warp.Out.Ace. Star Trek: AIIPtsRelayAce, 
Beam.Down.Ace, Blingl.Ace, Bling2.Ace, 
Bridge.Kirk.Ace, Cornrnunicatr.Ace, Explosion.Ace, 
Grandmother.Ace, lm.KirkAce, Impulse.Ace, 
Kirk.Here.Ace, Kirk.Intro.Ace, Phasor.Ace, 
PhotonExpl.Ace, PhotonExp2.Ace, PhotonTorpe.Ace, 
RedAiertAce, ShortTheme.Ace, Static.Ace, 
ThemeSong.Ace, Exec.Ace, Trek.Door.Ace, 
Trek.Theme.Ace & VulcanMind.Ace. 

Yes, the Software Library will be open for 
those wishing to obtain disks from last month {the 
auction made it impossible last month}, and this 
months Disks of the Month (and of course any 
others we have released - Ed 

~:~1m. ~w, }1~,:;: Till 'fl1 r'O)tc:' l'l\ r ~ .J..:o , , Ju1 ~) 
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By Simon Skill 
Thanks for the great response, on the first day I got two 

phone calls, both of them about the Apple-IBM romance joke 
I put in the article. I personally dislike IBM as I hear IBM 
everywhere nowadays and very little about my Apple ][ 
computer. 

One of the callers wanted to know how I connected the ][e 
to the IBM (This is very simple to do if you wish to transfer 
files between machines- Ed). I won't mention any names. 
Another caller was Ms Ann White saying go right ahead with 
the hints, so here they are. The following hints apply to 
DOS 3.3 NOT ProDOS - Ed. 

How to control your disk drive (or Things That 
Make Your Disk Drive Go Hmmm ). 

It is easy to control your drives with a simple peek 
command. 

Typing PRINT PEEK(49379) turns the write protected 
lights on if they are fitted on the drive(s). 

Typing PRINT PEEK(49385) turns the drive 1 motor on. 

Typing PRINT PEEK(49387) turns the drive 2 motor on. 

You could write a short program with the above codes that 
goes something like tum on lights 01, lights 02, lights 01 
etc. 

Taking over control of the Reset key . . . 
Amazing! Fantastic! Cowabunga! There is a way to take 

over the Reset key. All you have to do is know how to type 
in a few numbers, commas and the word POKE. The magic 
formula is as follows: 

64k Apple I I+ 
with B&W monitor. 

$150.00 ONO 

Apple][ MotherBoards 
in working order 

$30.00 ONO 

Contact K. Saggers 
C/- Phoenix BBS 800-4660 

or Apple-Q { see back page }. 

To make Reset reboot: 
POKE 1010,0: POKE 1011,0: POKE 1012,0 

To make Reset RUN: 
POKE 1010,102: POKE 1011,213: POKE 1012,102 
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In fact, almost any combination of numbers can be used 
to make Reset reboot. Oh, and by the way, if Reset is 
pressed when it is used to RUN, you will have to reboot 
anyway. Also, if you have less than 48K, run down to the 
computer store with $120 because it won't work with less 
than 48K. 

Read this one: I'm not ASCIIng for much ... 
DOS 3.3 manuals say that a file name must start with a 

letter. THAT'S NOT TRUE! File names can start with a 
character whose ASCII value is over 63. This means that you 
can use ALL the letters,@,[,\],"· and_. (And the lower 
case equivalents of these characters). 

Diskettes and cassette tips ... 
Keep that old cassette player, if you have not thrown it 

away yet, the one you used before the disks became so 
handy. You never know, one day the drives might foul up 
when you're in the middle of a SUPERDA TABASE. It does 
happen. If things go wrong, you can save to tape, fix your 
drives, LOAD from tape and SAVE SUPERDATABASE to 
disk. Try this: remember, it does happen. 

That's all this month, I had better stop now otherwise I 
will fill up the whole newsletter {I should be so lucky - Ed), 
and I'll have nuttin' left for next month. Thanks everyone, 
for your calls. See ya Applers. 

Simon is one of our younger club members and 
has offered his services to the club so if you have 
any comments please let him know by the clubs 
mail box or via phone between the hours of 3.30 
and 8.30 P.M. on (07) 800-1099 - Ed. 
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I[®,w~®~W®~~ 0® n TMS Peripherals 
TMS Peripherals was selling the RAMfast 2.01 upgrade 

'10) .(1;, ROMs. If you don't already have these, get them, they're 
.!..%@1}D@ITL!o incredible. The ROM config program is now mouse based, 

and MUCH easier to use. They were showing off their 
by Dale Rodgie and a cast of Thousands cassette-cartridge (same size, different material) tape backup 

It seems that each year the KansasFest just gets better and systems. VERY nice. 60megs in 15 minutes is nothing at all 
better. Held in Kansas City in July each year, the to sneeze at. Compare to Copy ][+ (what, 4 days or 
KansasFest, as it is called, is now the major showplace for something?) 
Apple II products. (I hear they also show Macs there) Over 
the past few years, Apple Computer has made major Seven Hills Software 
announcements at the KansasFest - so to have third party Seven Hills software was demoing a really nice heavy-
companys. duty equation editor, which will import into Apple Works GS 

This year was no different - Apple announced three new desktop publishing and most other stuff (most like 
products for the Apple II's, most of which should be out by Graphic Writer III, which was shown right next to it). It's 
the end of the year. Many other cornpanys were also showing called FormEdit, but they're looking for a more marketable 
off their new wares. name (someone give'm a call!) Rumor has it that a 

In the past three years Resource Central (a.k.a. A2- Mathematica GS exists and has been offered up fo; 
Central) (a.k.a. Open-Apple) has run an Apple II confrence publishing. We're going to check into this one. 
just before the KansasFest 

Most of the information below comes from a US bulletin Apple 
board service. People who attended KansasFest uploaded Apple was absolutely tremendous- not their booth, which 
messages to the bulletin board during the 'Fest. I have was pretty dam boring, but their staff - Matt Deatherage, 
included the info on new products plus the stories, jokes and Dave Lyons, Andy Nicholas, Greg Branche- who all took 
quotes from the 'Fest to give you an idea of what it would be time out to give us (Procyon, Inc) tech support at the show. 
like being there. I plan to find out for myself next year. I am Thumbs up, hugs and kisses and a hearty hurrah (gotta 
planning a trip to the States in July. For those interested, here stop hanging around Linda!) to all these guys! (By the way, 
are the dates: Linda, where's those pictures?) I won't describe System 

Software 6.0, as we didn't see too much of it and others have 
A2-Central Summer Conference 1992 Dates already done a fme job of it. Oh, they also had the latest DTS 

July 21 and 22 Collages (not confirmed as yet) CD-ROM, "Gorillas in the Disc". 
July 23 and 24 Main Conference 
July 25 and 26 Apple Central Expo (KansasFest) Three-SIJ:ty Pacific 

We saw Lane Roath here, chatted with him for a bit­
To find out more about the conference, check out the really nice guy. He was selling Dark Castle, Warlock, and 

March A2-Central issue next year. You can either subscribe some other stuff. But what blew us away was that he had 
yourself or check out the club's copy. Dark Castle source code for $50. Way to go! We can use as 

I I 
much idea sharing as possible to get people back into the 

_ Booths/New Products _ spirit. Unfortunately, he also said he hadn't started an Arrn<1 
Alley port, but he's got all the source and it could be done 

Here is a detailed report from Javaid Bazyar on each of the (hinted that he'd start soon). 
companies that attended KansasFest. I have also included 
reports from other people on the different products. Claris Corporation 

After having been missing from the last couple Apple II 
The Canonical Guide to KansasFest '91 shows, Claris finally shows up- with no Apple II software 
Or, what the hell we did for two days at the Apple Central whatsoever. However, they left their booth empty for 
Expo several minutes, and this oversight did not go unnoticed-

someone sucked in the spirit in the air and prominently 
Copyright 1991, Jawaid Bazyar (inventor of the von displayed (on a Mac screen) a "Apple II Forever! Mac 
Neumann architecture, patent pending) Free distribution sucks!". An appropriate message. Bravo! 
allowed as long as this notice remains. Typos courtesy of 
sleep deprivation experiment #2 (required to recover from DreamWorld Software 
excessive sleep the night before). DreamGraflx looked incredible- it's still in beta, but the 

Well, Tim Meekins, Derek Taubert, and myself just got improvements from previous demos and betas are 
back from KansasFest (evidently, only the second ones to astounding. It looked better than most paints I've seen on the 
arrive horne and not instantly pass out). We saw some Amiga, Mac, and STs combined. Keep it up Jason and 
mighty impressive stuff there. We'll go booth by booth (at Steve! 
least those we attended with enthusiasm). 
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We talked to Paul Statt about a few things, most notably 
the ASIC. He got to play with it for a week after I sent it 
b~ck to Ton~· P?.\!1 wa~ 1'~0 very nice... he gave away an 
amazing number of magazines ... 

Interplay 
Bill Heineman is God. Well, if not THE God, then at 

least a member of the Greek pantheon. No doubt about it. 
He came over to our booth first thing in the morning 
Saturday- he was our first victim.. He recognized Tim's Z­
demo ("Say... I know *that* [pointing]") right off and they 
had a good chat for 20 minutes or so. He came over later to 
talk to me about the ASIC some more, and explained to me 
what Tony Fadell has to do to make it really crank. I was 
stunned. The guy knows everything. He wasn't ever in his 
booth, as far as I know, but who cares! Bill H. was there! 

tO/New Concepts 
Larry O'Connor was very r.ice and supportive of the GNO 

project. Also supportive was Scott Gentry, who gets his 
name carved in granite at our forthcoming corporate 
headquarters for being the first person to buy a copy of GNO. 

Hats off to you (By the way, keep the original stuff- it 
may be worth a lot of money someday!) Pete Snowberg 
handed out a flyer on the DSP card - it looks really 
impressive! I'll try to talk him into uploading the specs to the 
net and GEnie. He said it was going to support virtual 
memory, but not memory protection, until I started asking 
him some questions and making some suggestions - and an 
idea hit him. Voila, memory protection was listed on the flyer 
the next day. GNO is one step closer to being a true Unix. 

Tim and Derek both bought TWGS 32k cache upgrades, 
and did the upgrade on our table at the 'Fest. Dhrystone test 
went from 632 without to 672 after the upgrade- all at 7MHz. 
Graphics applications seem MUCH faster than this (ZLaunch 
scrolling was reportedly twice as fast). (That's okay, my Zip 
~still cool as an icicle -Tim's GS was topless the whole time 

! to heat problems) 

SSSI, Inc. 
These guys (who Bryan Zak was there with in spirit, if 

not in flesh -seems he found out Friday night he was an SSSi 
employee :-)had a number of products for demo - Editl6, 
which seems to be the best available programmer's editor 
available; a beta of a new set of NDAs which were incredibly 
professional looking, very classy stuff (late summer release 
hopefully); Genesys isn't 2.0 yet, but it's looking 'much 
better now' (anyone remember Harry's father, the lunatic (no 
offense! :-)'Buddy' on Night Court?). 

Byte Works, Inc. 
Talked to Mike Westerfield- yet another great guy at the 

show. He had info on Orca 2.0 (which we lost!) and it 
looked rather impressive. Complete support for GS/OS in 
Orca; a new Integer BASIC compiler (with source, part of a 
package to help teach programming and compiler theory); gno 
news on a gnu C (although he told me earlier he'd be working 
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on it soon); oh, and he's still looking for a DOS 3.2 FST. 

Computer Covers Unlimited 
These folks had an interesting display whereupon they 

poured kool-aid onto a keyboard for hours on end _(protected 
of course with a keyboard condom). They didn't have a IIgs 
keyboard to demo the GS version of the cover, so Tim's IIgs 
was used several times for demos (which, by the looks of his 
keyboard, could use a cover or, say, a small thermonuclear 
blast). They seemed to move an awful lot of merchandise. 

Econ Technologies 
Nice ladies. Internal (power supply replacement) SCSI 

hard drives. You can even buy just the power supply case 
(although for a horribly hefty $299). Their drive combos are 
also somewhat on the expensive side. They seem to be going 
for the 'BMW' approach to marketing. 

Mlcol Systems 
Besides Micol BASIC (no comment), they were showing 

off their new 1.6MB drive. Too bad Apple has announced 
the SWIM card (only 1.4, but it's a standard). 

PC Globe 
Lots of folks who had a nice GS program and loud 

sweatshirts. Really, I looked at the program a little bit and it 
seemed to do the same stuff the PC/Mac versions did, only 
with more style. (Might've been the machine it was running 
on, I'm not sure.) 

Resource Central 
We talked to Randy Brandt (what a NICE guy, where's 

that ROSE update? Saw Tom Weishaar, YATG (yet another 
II god). I didn't have the nerve to talk to him - what would 
say to Tom Weishaar? I didn't think bowing and kissing his 
shoes would be appropriate in public - maybe I can make an 
appointment. 

Roger Wagner Publishing 
Had HyperStudio demos running in several booths 

which had been conglomerated into one Super-Booth (Sam 
Walton watch out). We happened to be in the bug-busting 
room when a fellow from Roger Wagner was debugging 
HyperStudio 3.0 with Dave Lyons - I don't know much 
about HS, but the title screen looked incredible! 3200 colors, 
and HyperStudio 3.0 supports it! Too bad it was in the bug 
room, but Dave was working on it so it'll probably be out 
next week. 

Sunset Laboratory 
We had fun stepping in front of the light sensor hooked 

up to his data acquisition system on a //e. He also had a Casio 
SK-1 sampling keyboard with a mike going into a GS. 

Zip Technologies 
They had some suits who spent lots of time hard-selling 

folks. I don't mind, they gave me an "EAT MY DUST 
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Mac ... " sign which went as follows: 

Hyperspeed for $149 GS+ Magazine 
This Apple IIgs is running 3 times 

faster than the average Ilgs. 
Faster than most Macintosh computers. 

Thanks to the Zip GS 

What a company! They also said they're coming out with a 
line of low-cost hard drives which they claim will be the 
fastest available for the IIgs. Knowing that last part to be 
pure marketing hype, I played along, but their strategy is 
good- they should do good in the void left by Ingenuity. 

Applied Engineering 
No booth but they had a roving tech-hermit. GS-RAM III 

is out in a half-card format, takes 4 megs (lmegx4 chips) and 
is of course fully DMA compatible. Tim says it looks like an 
old Language card. The rep also promised Derek they'd fix 
his Vulcan-40 "this" time - they've almost insultingly blown 

~wwll® m®©fiw~©~1b 
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by Dale Rodgie 
Apple joins the Police ... 

Apple Computer has won a 5.2 million dollar contract to 
supply computers to the Queensland Police Department. 

New Macs Are Coming ... 
Word is that Apple will release at least six new models at 

the Comdex computer show in the U.S. on the 21st of 
October. I have also been told that they plan to release two 
new printers at that time also. Here's the rundown ... 

Macintosh Classic II - The Classic II is like the 
Macintosh SF/30 it replaces except it does not have a slot. It 
will use a 68030 microprocessor and sell for under $3000.00 
in Australia. 

PowerBook • The PowerBook is a notebook computer. 
There will be three models released at the show. They contain 
a hard drive, however, a floppy drive will be extra. No prices 
available at this time. 

Macintosh Quadra - Apple plan to release two models of 
the Quadra which will run 40% faster than the Macintosh 
Ilf.x. Both Quadra models will contain the 68040 
microprocessor. One of the models will come in a case 
similar to the Macintosh Ilci. In fact you will be able to 
upgrade your CI to the Quadra. The second Quadra comes in 
a tower case (on it's side) and sits on the floor. No prices 
available at this time. 

New Printers - No information is available on the printers 
at this time. This will be the biggest model release that Apple 

Apple-Bug 
him off four times (once sending it in, and three times on 
their lovely 900 number) (See LRO for info on the cache 
upgrade). 

InSync 
Also in the "no-show" category was InSync. So just 

exactly where is this bug fix? Not like it matters to me or 
anything ... 

Procyon, Inc. 
Last but gnot least, we demonstrated our gnifty gnew 

GNO multitasking environment for the IIGS. We got lots of 
support from the Apple guys, and several reps from users 
groups all over the country. We made some incredible 
contacts, and a lot of friends. KansasFest was the second­
best experience I've ever had in my life;-) We can't wait 
until gnext year! An official press release detailing the GNO 
system will follow in a few days on all the grooviest on-line 
services. 

has done at one computer show. 

New Apple lie Card Software ... 
Apple will soon release version 2.0 of the Apple lie 

Software for the Macintosh LC that allows you to print to the 
Style Writer from the Apple lie emulation mode. 

Dead Sea Scrolls and the Macintosh ... 
A Macintosh computer has been used to reconstruct 

unpublished sections of the Dead Sea Scrolls. Since their 
discovery in the late 1940's and early 1950's the job of 
deciphering the scrolls are in the hands of a group of 
scholars. However, only part of the text has been 
published. Dr. Wacholder is going blind and could not wait 
for all the scrolls being published. What had been published 
was a document called "A Preliminary Concordance to the 
Hebrew and Aramaic Fragments". This concordance 
contains lists of "word groups" and a reference to it'~ 
location in the scrolls. With the help of Martin Abegg and a 
Macintosh computer, the concordance was scanned into the 
computer and a program was written to reconstruct the 
information. The reconstructed version of the scrolls have 
now been published so that other scholars can study the 
scrolls. 

C\~~~@~@ ~lfil©o® 
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October 20th 
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~~S~o~ft~w~a~re~L~ib~ra~r~y~O~rd~e~r~F~o~rm~~~' ~~~M~em~b~e~rs~h~ip~/~R~e~ne~w~a~I~F~o~r~m~~' 
Name: ............................................................................. . 

Address: ......................................................................... . 

Suburb: ........................................ Post Code: ............. . 

0 Mail order or 0 Pick-up order at meeting 

Payment By: 0 Bankcard 0 Mastercard 

0 Cheque 0 Money Order 0 Cash (pick-up) 

Credit Card !'lumber: ....................................................... . 

Expiry Date: ........ /........ Membership !'lo: ................ . 

Signature: ........................................................................ . 

Disk or Pack Name 5.25' 3.5' Price 

············································ ::J ::J $ ......... 

............................................ ::J ::J $ ......... 

............................................ iJ ::J $ ......... 

............................................ 0 iJ $ ......... 

............................................ 0 0 $ ......... 

............................................ 0 0 $ ......... 

............................................ 0 0 $ ......... 

············································ iJ iJ $ ......... 

............................................ 0 0 $ ......... 

Sub Total $ ........ . 
Post & Pack $ 2.00 
Total Cost $ ........ . 

Hardcopy Library Order Form 

Name: ............................................ Member No: ........... . 

Book or Magazine Names: 
[ 1] ····················································································· 
[2] ····················································································· 
[3] ····················································································· 

[4] ····················································································· 

Signature: ......................................................................... . 

#\[?J[p)~@o~Ql]@ lMJ@@@~~[ji)@ 
is a publication of 

Apple-Q Inc. 
{the Brisbane (Apple) Users Group) 

Postal Address: 
P.O. Box 721. South Brisbane. Qkl 4101. 

Meetings Held at: 
Hooper Education Centre 

Kuran Street. Wavell Heights 

Please fill in this form, tick the appropiate boxes and send the fonn 
to Apple-Q Inc., P.O. Box 721, South Brisbane, 
Queensland 4101. Please enclose your remittance with this form. 

0 Membership Application 
0 Renewal of Membership 

Membership Number: .............................. . 

Membership Fees 
0 $10.00 Joining Fee (frrst year only) 
0 $25.00 Adults, Family & Students 

0 $10.00 AssociateMembeiship(BBSonly) 
0 $50.00 Corporate Membership (Schools/Business Houses) 

Member's Details 

Name: .............................................................................. . 

Street: ............................................................................. . 

Suburb: ........................................................................... . 

City: ................................................................................ . 

State: .................................. Post Code: ....................... . 

Home Phone: ( ............ ) 

Business Phone: (. ........... ) 

A membership list is published every year in the Newsletter. Only 
your Name, Suburb and Phone number, are listed. Do you require 

exemption from this list? 0 YES 0 NO 

System Information 
0 Apple II 0 Apple II+ 0 Apple //c 

::J Apple //e 0 Apple //gs 0 Apple /// 
0 Macintosh 0 Other: ....................................... .. 

Members are reminded that the copying of commercial software is 
not santioned by the Apple-Q Inc., and that members who do so, 
risk expulsion from the group. 
I hereby declare that the above details are oue and correct, and agree 
to abide by the Rules and Regulations of the Group. 

Signed: ............................................................................. . 

For Official Use Only 

Receipt Number: .......................... Date: ..................... . 

Status: ......................................... Paid: $ .................. . 

Exp. Date: ................................... . 



Apple-Bug 
The Newsletter of APPLE-Q Inc. (the Brisbane Users' Group) 
If not claimed within 7 days, please return to: 
P.O. Box 721, South Brisbane, Queensland 4101, Australia. 

'lJon't Cet your macnine master you . Cearn a6out it witn ~ppCe Q -----· 

Is your t}?Jnewa{ aue soon . . . . 

Registered by Australia Post • Publication No. QBG 3485 

SURFACE 
MAIL 

Please deliver to 

POSTAGg 
PAID 

AUSTRALIA 

C:hl&lillghllg AiCll((jj:r~§§? If so, fill In this slip and send it 
in as soon as possible. 

Name .............................................................. Membership# ............... . 

Address 

Suburb .................................... State ................... Postcode ................. . 
Please send this slip to: App1e-Q Inc. 

P.O. Box 721, South Brisbane, Qld 4101 
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